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Proprietary and restricted rights notice
This software and related documentation are proprietary to Siemens Product Lifecycle Management
Software Inc.

© 2015 Siemens Product Lifecycle Management Software Inc.

What's New in Solid Edge ST8

Part enhancements

Helical Curve command

A new Surfacing tab→Curves group→ Helical Curve command is available in the synchronous
and ordered environments.

For more information, see the Helical Curve command.

1-2 Solid Edge ST8 Release Notes

Lesson 1: Solid Edge ST8 Release Notes



Solid Edge ST8 Release Notes

New BlueSurf option

A new Deselect All option was added to the BlueSurf command bar. If you are in the Cross
Section Step, all cross sections are deselected. If you are in the Guide Curve Step, all guide
curves are deselected.
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Create a pattern by table

You can create a pattern feature where the pattern instance locations and orientations are defined in
an Excel spreadsheet. For more information, see the Pattern by Table command.
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Recognize Patterns command

A new Recognize Patterns command is available in the synchronous environment to find
patterns for any given collection of faces. After you identify the master geometry, the command
looks for patterns of similar occurrences. Identified patterns are displayed in a table, and you can
modify or accept the patterns.

The command does not recognize procedural features, such as holes, dimples, and existing patterns.

For more information, see the Recognize Patterns command.
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Weldment commands

While in a weldment assembly, you can now create weldment features in a separate part file. You
create a new part file in-place. In the assembly file, choose the Home→Assemble→Create Part
In-Place list→Create Part In-Place command. The weldment commands in the part environment
are located on the Home→Solids→Sweep list.

Synchronous weld commands

• Fillet Weld

• Groove Weld

Ordered weld commands

• Fillet Weld

• Groove Weld

• Stitch Weld

• Label Weld

Assembly enhancements

Top Level Assembly document filter

A new Top Level Assembly document filter was added to the Open File dialog box. Selecting this
option only shows top-level Solid Edge assembly documents *.asm.

For more information, see the Open command.
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Chinese and Taiwanese standard parts now delivered

A variety of Chinese and Taiwanese standard parts are now delivered with the Standard Parts library.
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Repair Missing Files dialog box

The new Repair Missing Files command located under the Inspect tab → Evaluate group, opens
the Repair Missing Files dialog box which contains commands to locate or replace missing files. If
files are missing, the command automatically executes on Open.

The following commands are available on the Repair Missing Files dialog box:

• Search in - Use to browse and define folder paths to locate files.

• Scoll to - Use to scroll to a part in PathFinder.

The following commands are available on the Repair Missing Files dialog box and on the assembly
Home tab → Modify group menu:

• Replace Part

• Replace with Standard Parts

• Replace with New part

For more information, see Repair Missing Files.
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Standard Parts Administrator enhanced

Several enhancements have been made to the Standard Parts Administrator:

• A new Add Custom Property command creates custom properties for all non-generated parts
within a selected category.

Custom properties are generated automatically when you generate a part. As an administrator
you are not required to create and populate the custom properties in advance for each
non-generated part. However, if you have specific requirements for either a category or part,
you can create the custom properties and set the values that are used when those parts are
generated.

• Two new options are available on the Standard Parts Configuration Wizard when storing
standard parts in Teamcenter. These options provide additional naming rules information for the
specified Item Type.

o Use the Item ID pattern option if you have a specific item revision pattern you intend to
use with standard parts.

o Use the Revision pattern option if you have a specific revision pattern you intend to use
with standard parts.

• The Master_Delivery_DB_V1200.EN.ML.v12.00.ddb has been renamed Machining Library.

• The Master_Delivery_DB_V1200.EN.PL.v12.00.ddb has been renamed Piping Library.

• Tooltips provide detailed descriptions for all commands.

• Standard Parts Administrator dialog box enhancements include:

o When adding parts from the standard parts database, you can now browse multiple .ddb files.

o Detailed instructions describe how to use the various dialog box options.

o Help buttons have been added to each dialog box to provide a description of the options
available on the dialog box.

o An information button on the Add New Standard Parts dialog box displays an illustration to
clarify the part parameters.
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New Variable Table Motor

A new Variable Table Motor has been added to the assembly environment to support more complex
motions than can be achieved using the Rotational Motor or the Linear Motor. The motion for a
Variable Table Motor is based on incrementing variables in the Variable Table (see Variable Table
Motor command for more information). This new motor update also includes changes to the:

• Animation Editor Tool to include new Update options to improve animations when you
Simulate a Motor (Home tab→Motors group→Simulate Motor) .

• Pattern Along Curve command bar to include options to improve animation of patterns.

• Path relationship command bar to include new Offset Type options, Offset Value field, Flip
button, and Origin Point features to use when defining a Variable Table Motor.
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New Assembly relationship option

A new assembly relationship option has been added to the Assemble command bar Options dialog
and the Component Placement Options section of the Assembly page in the Solid Edge Options
dialog box. The new option only moves the placed part the minimum amount required to accomplish
the relationship. This option can improve placement performance. This is the default setting. An
option to revert to pre-ST8 behaviour has been provided.
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Program automation interfaces to create animations

Several API methods and properties were added to the SolidEdgeFramework.View automation
object. to control various properties of animations . Using these interfaces, you can write your own
programs to create animations frame-by-frame, as you drag or reposition assembly components. For
example, you can use this API to create complex animations that require relationship suppression,
view orientation, and advanced formula computations to get a required animation movement.

A C# sample, SolidEdgeMovieRecorder, is available in the Solid Edge ST8 Custom folder.

For more information, see Creating assembly animations.

Wire Harness enhancements

Splice

The new Splice command creates a splice between wires.

For more information, see the Splice command.
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Assign Terminals command enhanced

The following enhancements were made to the Assign Terminals command.

• The Assign Terminals command now supports the selection of arcs when assigning terminal
geometry.

• You can use the Create PMI option in the Assign Terminals dialog box to create PMI for the
component name and terminal names.

For more information, see the Assign Terminals command topic.
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BlueDots enhanced

Enhancements have been made to BlueDots.

• BlueDots are now the same size as edit points on a path or keypoint curve.

• You can now fence select BlueDots.

• BlueDots are now at the top of the locate priority filter when editing split location.
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Reuse paths

You can now reuse path geometry to create wires, cables, and bundles. When you reuse a path to
create a harness feature, associativity between the path and other geometry is maintained.

For more information, see the Path command.
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Split Path in Harness

The Split Path command has been added to the Harness environment so you can split an existing
path while creating a BlueDot at the connect point.

The Split Segment command in the XpresRoute and Frame environments is now named Split Path,
but the functionality of the command in those envronments has not changed.

For more information, see the Split Path command topic.
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Path command enhanced

Several enhancements were made to the Path command in the Frame, Harness, and XpresRoute
environments. Some of these enhancements are common to all environments and some are specific
to Harness.

Enhancements common to Frame, Harness, and XpresRoute

• The Circular Cutout Locate option has been moved from the Path command bar to the Locate
Filter list and renamed Cylindrical Faces.

You can use the option to select cylindrical and partial cylindrical faces.

• The new Flip option reverses the path direction between cylinder ends.

• You can now set the fixed length of curves with no free edit points.

When you set the fixed length, a free edit point is added at the midpoint (1) of the longest
segment between edit points on the curve.
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• You can use the end point of an existing path (1) to create a new path (2) that is tangent and
continuous to the original path.

In Harness, a BlueDot is created at the connection point.

In other routing environments, a BlueDot is not created.

Enhancements specific to Harness

• The new Show Connector Information option displays the connector and terminal information
for the selected connector. This helps you select terminals to create paths between connectors.

For more information, see Construct a path through selected keypoints.
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• The new Assigned Terminals option changes the locate filter between all elements and assigned
terminals only. This is helpful when there are many terminals in a conductor and you want to
select only the terminals that are assigned.

For example, with the option deselected, you can locate both the center point (1) and cylindrical
face (2).

If you select the option, you can locate the center point (1) because it has an assigned terminal.
However, you cannot select the cylindrical face (2) because it has no assigned terminal.
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Harness Wizard enhanced

The Harness Wizard now alerts you there are multiple instances of a connector within the assembly
and provides you the opportunity to map the correct instances with the appropriate .cmp file entry.
Previously, when multiple instances of a connector appeared in the assembly, each instance of
the connector was randomly mapped to an entry in the .cmp file. This led to incorrect mappings
in many cases.

Sketching enhancements

Include command (ordered environment)

The Include command in the ordered environment is renamed to Project to Sketch command. It is
now the same as the synchronous Project to Sketch command. Both commands have the same
options dialog box.
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New options for Polygon by Center command

The Polygon by Center command now has options for creating a polygon where the defining circle is:

By Midpoint —Inscribed.

By Vertex —Circumscribed.
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Symmetric line option for the Line command

While in the Line command, you can press the S key to switch to symmetric line placement mode.
The line endpoints are symmetric about the first point that you click.

Draft enhancements

Annotation usability improvements

Annotations and leader lines now have a standard set of color coded handles to indicate their
behavior during edits. Also, the prompts displayed in PromptBar now are specific to the type of
object you select and the handles that are available to edit it.

These changes apply to draft, profile sketches, and to model PMI.

Color-coded modification handles

There are three types of color-coded handles that appear on an annotation, its leader line, and its
terminator. The colors identify the type of edit the handle performs.

Example

Handles for a 2D annotation with no break line:

With a break line, more edit handles are available:

1-22 Solid Edge ST8 Release Notes

Lesson 1: Solid Edge ST8 Release Notes



Solid Edge ST8 Release Notes

The handle colors are defined by the Handle 1, Handle 2, and Handle 3 colors on the Colors
tab in the Solid Edge Options dialog box. The default handle colors are different in 2D and 3D
environments.

For information about how you can use these handles, see the following help topics:

• Annotation edit handles

• PMI edit handles and cursors

Improved alignment indicators for editing leader lines

Dashed lines now show how you can snap a leader line to change its orientation. For more
information, see the related What's New topic, Snap-to indicators for annotation and dimension
editing.
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Compare two drawings

The new Compare Drawings command finds the differences between two versions of the same
draft file, on a sheet by sheet basis. You can save the differences to a file for later review.

For more information, see the Compare Drawings command.
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Concentric diameter dimension enhancements

It is faster and more efficient to use the Smart Dimension command to place multiple dimensions
that measure the diameter of concentric circles or arcs.

• After placing the first diameter dimension on a circle or arc, you can use the new Concentric

Diameter option on the command bar to add consecutive dimensions to concentric
geometry with a single click for each one.

• Concentric diameter dimensions are stacked, aligned, and spaced automatically during
placement and editing.

• Concentric diameter dimensions are created in alignment groups. This means you can:

o Drag any dimension in the alignment group and all of the dimensions adjust along with it.

o Alt+drag a single dimension in the alignment group to manipulate it independently of the
others in the group.

o Use the following commands to manage the membership of dimensions in the dimension
alignment group:

■ Remove from Alignment Set

■ Break Alignment Set

■ Split Alignment Set

• To improve legibility, you can control how dimension text is arranged in the concentric diameter
dimension stack. Use the new option, Alternate text positions, on the Lines and Coordinate
tab in the properties and the style to specify this.

For more information, see the help topic Place concentric diameter dimensions.
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Custom material properties in Draft, Sketch, and PMI

Solid Edge ST7 introduced many Material Table enhancements, including the ability to define custom
material properties for parts. In ST8, you can reference custom material properties on a drawing,
in a part or assembly sketch, and when adding PMI in a model. For example, now you can display
custom material properties in a callout or other annotation. You also can show custom material
properties as a data column in a parts list.

You can reference custom material properties:

• In annotations, using the Select Property Text dialog box and setting the source of the property
text to either From Graphic Connection to Part or From Graphic Connection (for an
assembly). For more information, see the help topic, Create property text.

• In a parts list, using the Columns tab in the Parts List Properties dialog box. For more
information, see the following help topics:

Create a custom table column for user-defined content

Example—Show custom properties and materials in a parts list.

• Anywhere you can type format codes to modify reference and property text output—The
mechanism for referencing a custom material property is the new /CM property text code. You
can add this as a modifier for the custom material property that you want to extract, using the
syntax %{CustomMaterialName/CM}.

To learn how to define a custom material property, see the help topic, Create a custom material
property.
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Dimension usability improvements

Dimensions now have a standard set of color-coded handles to indicate their behavior during edits.
Also, the prompts displayed in PromptBar now are specific to the type of object you select and the
handles that are available to edit it.

These changes apply to draft, profile sketches, and to model PMI.

Color-coded modification handles

There are three types of color-coded handles that appear on a dimension. The colors identify the type
of edit the handle performs.

Example

Handles for a dimension (ISO standard):

More handles are available for dimensions using the ANSI standard:
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Note

The handle colors are defined by the Handle 1, Handle 2, and Handle 3 colors on the
Colors tab in the Solid Edge Options dialog box. The default handle colors are different in
2D and 3D environments.

PMI dimension edit handles (ISO standard)

PMI dimension edit handles (ANSI standard)
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For more information, see the following help topics:

• Dimension edit handles

• PMI edit handles and cursors

Improved connection indicators for projection lines

Dashed lines now show what a dimension is connected to, even when the projection line is not
shown. For more information, see the related What's New topic, Snap-to indicators for annotation
and dimension editing.

New dimension formatting commands

New formatting commands are available from the terminator handle of a 2D dimension or a PMI
dimension. To access the commands, select the dimension once to display all handles, and then click
the terminator handle point.

Note

This is not the same as a double-click, which may display the properties for the element or a
command bar instead of the context commands.

Terminator Type command
Displays a list of the available terminator types for the selected dimension or annotation.
Previously, you had to modify the object properties or the Dimension style (which controls
dimensions and annotations) to change the terminator.

Show Projection Line command
Shows or hides the projection line adjacent to the terminator handle.

Show Dimension Line command
Shows or hides the dimension line and terminator adjacent to the terminator handle.

Flip Terminator
Flips the dimension line and terminators inside or outside the projection lines. You can use
this command to improve legibility.
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Independent margin control in table cells

Two new options provide independent control of the horizontal margin and the vertical margin of a
table cell. The options are available on the General tab of the Properties dialog box for parts lists
and for all tables except hole tables.

• Vertical margin

• Horizontal margin

Note

The two new options replace the single Margin control. Both values are stored in Saved
settings.

1-30 Solid Edge ST8 Release Notes

Lesson 1: Solid Edge ST8 Release Notes



Solid Edge ST8 Release Notes

More hole properties for callouts

The following hole property values, which are specified in the model using the Hole Options dialog
box, now can be referenced in a feature callout in draft, profile/sketch, and PMI:

Tapered holes
Taper angle and R:L ratio

V-bottom option
V-bottom angle

Threaded hole size
Tap drill diameter, internal minor diameter, nominal diameter

You can access the property values using the Select Symbols and Values dialog box. For more
information, see the help topic Customize a hole feature callout.

The new two-letter codes (%XX) were added to the Feature Reference table in the help topic
Property text codes.
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More reference text enhancements

Solid Edge ST7 introduced the Select Reference Text dialog box to create associative
cross-references between the text in two annotations (callout, balloon, datum frame, datum target)
and between an annotation and a drawing view caption.

In ST8, support for reference text is now available for more types of annotations.

• In text boxes, you can insert reference text that extracts information from other annotations.

• In weld symbols that conform to the GOST standard, you can insert reference text into, and
extract reference text from, four text fields:

• Feature control frames can reference datum frame text that contains superscript and subscript
characters.

• You can reference the properties in the following view annotation objects, and show the
information in other annotations:

o Cutting plane lines, which are used to create section drawing views.

o Detail view envelopes, which are used to create detail views.

o Auxiliary viewing planes, which are used to create auxiliary views.
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Example

This auxiliary view plane line label can be displayed in an annotation such as a text box
or callout.

For more information, see the help topic Using reference text.
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New command: Technical Requirements

A new annotation command, Technical Requirements , is available for placing a numbered list
of technical specifications, manufacturing requirements, and other information on a drawing sheet.
Each line of text is a unique item that can be referenced from other annotations. You can predefine a
technical requirements list, and then store it to Saved settings for quick reuse.

For more information, see the help topic, Adding technical requirements.
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Parts list based on a subassembly

Now you can create a parts list based on a selected subassembly instead of a top level assembly.
The part numbers and item balloons are based solely on the subassembly.

A new option on the Parts List command bar, From Selected Subassembly , displays the
Select Subassembly dialog box. In this dialog box, you can choose a subassembly for building
the parts list.

For more information, see Subassembly drawing views and parts lists.

Solid Edge ST8 Release Notes 1-35

Solid Edge ST8 Release Notes



Lesson 1: Solid Edge ST8 Release Notes

Scaled nailboard views

Now you can scale nailboard views. Previously nailboard views were created with a 1:1 scale only.

New options, Scale and Scale Value, on the General tab of the Nailboard Drawing View Properties
dialog box and the command bar, control the nailboard view scale. From the command bar, you can
use the options to specify the scale for the nailboard view being created. From the dialog box, you
can use the options to edit the scale for an existing nailboard view.

Another option on the command bar, Set Sheet Scale, sets the sheet scale to match that of the
drawing view being placed.
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Snap-to indicators for annotation and dimension editing

In ST8, dashed lines indicate snap-to positions for dimensions and annotations. The dashed lines are
shown in the Select color, which is different in 2D and 3D environments. These changes apply to
draft, profile sketches, and to model PMI.

For more information about the handles mentioned below, see the related What's New topics,
Annotation usability improvements and Dimension usability improvements.

Leader lines
Previously, leader lines snapped to orientations at 0, 90, 180, and 270 degrees. In ST8, they
also can snap in 45-degree increments. The following aid is displayed when you begin to
move an annotation. When you click+drag the annotation onto one of these orientation lines, it
snaps to that orientation.

Dimension text
When dragging the dimension text or its edit handle, the intersection of two dashed lines indicates
the snap position for the text.

Break lines
When you Alt+drag the edit handle at the point where the break line connects to a balloon,
callout, or feature control frame, snap points appear on the annotation for you to change the
break line connection point. The break line orientation is always perpendicular to the horizontal or
vertical dashed line that is displayed at each snap point.
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Projection lines
When you select a dimension whose projection lines are turned off or are shortened, dashed
lines indicate what the projection lines are connected to.

Example

In this ANSI dimension, an edit handle was used to shorten the projection line. The dashed
line indicates the geometry connection point.

In this ISO dimension, the terminator handle was used to display a half dimension rather
than a full dimension. The dashed lines show the dimension line and the projection line
that were turned off.

Lines with jogs
When you select an edit handle on a jogged line and begin to drag it, a dashed line indicates the
new orientation of the line if you snap to it.
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Example

When you begin to drag the edit handle at the jog shown in the image at left, you can snap
to the dashed line shown in the image at right to straighten the projection line.
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Text boxes support associative text

Now you can insert and modify property text and reference text in annotations created with the Text

command . Use the new Insert Property Text dialog box, which is available from the command
bar when creating and editing text boxes, to select and insert both types of associative text. To learn
how, see the help topic, Create a text box that references another annotation.

For a brief description of the differences between reference text, property text, and symbol and value
codes, see Referencing properties.
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Thread dimension retrieval enhancements

Retrieved callout dimensions for threaded holes are attached to the thread graphic in the drawing
view. Previously, these types of dimensions were attached to the tap drill diameter. Below are two
examples of how the callout appears.

Note

Legacy files will not automatically update on open or go out of date. Updating the view will
cause the callout dimension to relocate and Dimension Tracker will display alerting you
to the change.

For more information about creating a PMI model view, see Create a PMI model view.

and

For more information about creating a PMI drawing view, see Create a PMI drawing view.
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Transparency as an option for reference parts

A new option turns transparency on or off for parts designated as reference parts in an assembly
drawing view. The default setting is on.

The Show reference parts as transparent option is available in two places:

• On the Edge Display tab in the Solid Edge Options dialog box, it sets the option as a file
preference for all new assembly drawing views.

• On the Model Options tab in the Drawing View Properties dialog box, it applies the option to
the currently selected drawing view.

Previously, reference parts were always displayed as transparent.

For more information, see Reference parts.
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UI to format property and reference text values

A new user interface makes it easier to apply format codes to modify the resolved values of reference
text and property text. You can use the new Format Values dialog box to insert format codes directly
into the property text and reference text strings. The dialog box is available for some annotations,
dimensions, block labels, table titles and column data, drawing view captions, view annotation
captions, and drawing view styles.

The Format Values dialog box is available in draft, ordered sketches, and for PMI. Previously, you
had to type the format codes using the proper syntax.

For more information, see the help topic, Format property text values.
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Underline text in callouts

You can underline the text in a callout using a new option on the Callout command bar, called

Underline Text . Each line of text is underlined separately.
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View annotation edit handles

• Modification handles were added to drawing view annotations, which are the cutting plane lines,
view plane lines, and detail envelopes used to create section views, auxiliary views, and detail
views.

Example

Note

The handle colors are defined by the Handle 2 and Handle 3 colors on the Colors tab in
the Solid Edge Options dialog box.

• A new shortcut command, Flip Direction, is available on the shortcut menu of a selected cutting
plane line to change the direction in which the cutting plane line points. If you change the view
direction, you must also update the derived section view. Previously, you had to edit a cutting
plane line to change the view direction.

For more information, see the help topic View annotation edit handlesView annotation edit handles.

Document management enhancements

Solid Edge Embedded Client

Software Compatibility

Solid Edge Embedded Client ST8 is compatible with the following:

Solid Edge Teamcenter Rapid
Start Teamcenter 9.1 Teamcenter 10.1 Teamcenter 11.2

ST8 10.1.4.x 9.1.3.x 10.1.4.x 11.2*
Teamcenter Rapid Start replaces Teamcenter Express starting with release 10.1

Teamcenter 9.1 adds 64-bit support (32-bit and 64-bit Teamcenter Server support on Windows)

Teamcenter 11.2 adds UTF-8 support for Windows (encoding used between TcServer - Database)

*ST8 supports Teamcenter 11.2 for testing purposes only (not for production use)
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Solid Edge Embedded Client ST8 is not supported with:

• Teamcenter 9.0, 10.0, 11.0, 11.1

• Teamcenter 8.x

• Any Teamcenter release prior to 8.x.

• Any Teamcenter Express version based on any of the above.

Solid Edge ST8 is the last release that supports Teamcenter 9.1

Solid Edge ST7 was the last release that supported Teamcenter Express 9.1

Solid Edge ST5 was the last release that supported:

• Teamcenter 8.1

• Teamcenter 8.3

Teamcenter preferences

New Teamcenter preferences introduced with this release:

SEEC_Synchronize_ItemNumbers
While not a new preference, this preference now has the capability to define item number
ownership. Teamcenter is supported as the item number owner as well as Solid Edge. The
/Master option manages this new functionality. Additionally, the scope of this preference now
supports Site, Group, and Role.

SEEC_Synchronize_VirtualComponents
When set to 1 (True), adds Item Revisions with no Solid Edge datasets to a Solid Edge Assembly
as virtual components. Default is 1 (True).

SEEC_Diagnostics_BOMValidation
Checks for BOM mismatches when a Solid Edge Assembly is opened or uploaded. Set to 1 to
enable BOM validations. Default is 0.

SEEC_Diagnostics_BOMDuplicateIDs
Checks and optionally removes duplicate Solid Edge Assembly occurrence IDs found in the
Teamcenter BOM. Set to 1 to enable logging. Set to 2 to enable logging and remove duplicate
occurrences. Default is 0 and logging is disabled.

AWC_SEEC_OpenSupportedTypes
Specifies the object types that Active Workspace Client can open in Solid Edge. Only Item,
Item Revision, and Dataset types are supported. If this preference is not specified, the Active
Workspace Client does not display the Open in Solid Edge command. This preference is
supported beginning with Active Workspace 2.4.

Teamcenter preference deprecated with this release:

SEEC_StructureEditor_Enable_Pre10
Beginning with this release, this preference is no longer used.
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For additional information, see the Teamcenter Preferences section of the Solid Edge Embedded
Client Guide for Users and Administrators.

Open a Solid Edge document from Teamcenter rich client

In addition to double-clicking a Solid Edge dataset, you now have a second option for opening
a Solid Edge document directly from the Teamcenter rich client. In Teamcenter 10.1.4, 11.2 and
higher, enhancements to Teamcenter rich client enable you to select an Item, Item Revision, or Solid
Edge dataset, click Open in Solid Edge from the rich client toolbar, and the associated design
data opens in Solid Edge.

The Teamcenter preference, SEEC_TcClient_Enable_Open_Cmd, delivered by SEEC
Administrator, enables or disables the Open in Solid Edge command.

For more information, see the help topic Open a Solid Edge document from Teamcenter rich client,
and Teamcenter Preferences in the Solid Edge Embedded Client Guide for Users and Administrators.

Command line support available for all data preparation utilities

All three data preparation utilities: Analyze, Link Fix-Up, and Modify, can now be run from a
command line. You can use command line options to make preparing documents for the managed,
or unmanaged environment easier.

For more details, see the Solid Edge help topics, Analyze Solid Edge Files, Link Fix-Up, or Modify
Solid Edge Files.

Add to Teamcenter enhanced to support naming rules

You can use the custom properties Pattern_ItemID and Pattern_Revision to automatically assign
naming rules to files when an item type has a naming rule on either the Item ID or Revision, or both,
and you are importing documents into Teamcenter. Supported file types include:

• Solid Edge document types (.par, .asm, .dft, .psm, .pwd)

• Microsoft Word (.doc, .docx)

• Microsoft Excel (.xls, .xlsx)

• Image (.bmp, .tiff, .jpg, and so on).
The properties are stored in the .tmp file when you use the data preparation tools to populate
the values.

For more details, see Naming rules and Add to Teamcenter in the Solid Edge help topic, Working with
Add to Teamcenter. Additional information is available in Naming rules and revision naming rules.

Updates to naming rule behavior in Solid Edge Embedded Client and Structure Editor

Naming rules define the data entry format for a business object property when you create a new
object, for example, when you create a new revision (Revise) or copy an existing item.

A revision naming rule is a business rule that defines the naming convention and sequence for a
revision property.

Naming rules consist of two components:
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• Pattern - Variable that defines the format (example: NNNNN)

• Counter - Defines the increment each time it is used.

For ST8, naming rule behavior is changed as follows:

• New Naming Rule Pattern column behavior

In common property dialog boxes, the Pattern column is not shown unless the number of patterns
with counters is greater than 1. If multiple documents are displayed, and one of the documents
meets the requirements for presenting the Pattern column while others do not, the column is
displayed. Documents that do not meet the requirement display with a Pattern column cell that
is read-only and with a null value.

• Item ID and Revision cell behavior

When the Teamcenter preferences, SEEC_MakeReadOnly_ItemID and
SEEC_MakeReadOnly_Revision are set to True, they cannot be overridden by Teamcenter. The
Item ID and Revision fields of common property dialog boxes are read-only.

• Assigning Item ID and Revision

Three elements are involved in assigning values for Item ID and Revision: generation, validation,
and uniqueness. The following table describes how common property dialog box cells are
populated with values when you interact with common property dialog boxes and the revision
is driven by naming rules.

Case Item ID Revision Comments

1 <empty> <empty> Generate ID and
Revision

2 User defined <empty> Validate ID and
generate Revision

3 <empty> User defined
Generate ID and
Revisions; user's value
is overriden

4 User defined User defined Validate ID and
Revision

Note

This information is not applicable when a Revision Naming Rule is used.

For additional information, see the help topic Naming rules and revision naming rules.
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Item Number integration enhanced

Item Number generation is enhanced to support a parts list where the item numbers are associated
with a user-selected subassembly and the item numbers are equal to the Teamcenter Find Numbers.
The enhancements include:

• The ability to define Item Number ownership using the /Master parameter for the preference
SEEC_Synchronize_ItemNumbers. Ownership determines the application responsible for
Item Number generation. When /Master=Both, item numbers are generated in the application
that created the new occurrence. When /Master=Tc, or /Master=Teamcenter, only Teamcenter
can generate item numbers.

• A new command, Item Number Status, that checks for out-of-date Item Numbers.

• A new assembly environment command to synchronize Item Numbers.

• Support for Item Number ownership in both Add to Teamcenter and Add to Teamcenter -
Interactive.

Note

The Teamcenter preference, PS_new_seqno_mode, should be set to Existing when
synchronizing Solid Edge Item Numbers with Teamcenter Find Numbers. The value of this
preference is displayed on the Solid Edge Options→ Item Numbers page.

For details, see Synchronizing Item Numbers with Teamcenter Find Numbers in the help topic,
Item numbers in assemblies.

Additional information is available in Item Number Status command.

New Item Number option

When Solid Edge Item Numbers are integrated with Teamcenter Find Numbers, the Teamcenter
preference PS_new_seqno_mode determines how Teamcenter generates new Find Numbers. The
value of this preference is now visible in the Find Number generation mode option on the Solid Edge
Options→Item Numbers dialog box. This option assists you in validating configuration options
that influence Item Numbers.

Note

The Teamcenter preference, PS_new_seqno_mode, should be set to Existing when
synchronizing Solid Edge Item Numbers with Teamcenter Find Numbers.

For details, see Synchronizing Item Numbers with Teamcenter Find Numbers in the help topic,
Item numbers in assemblies.

New option when opening draft documents

Assembly size is considered when a draft is expanded. When the assembly is evaluated as large
(as defined on the Solid Edge Options→Assembly Open As dialog box), and it is simplified, the
assembly is expanded level-by-level. You can now use the Use large assembly mode check box on
the Open File dialog box to choose how an assembly that is not simplified is expanded when you
open a drawing in Solid Edge Embedded Client.
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For details, see Use large assembly mode in the help topic, Open File dialog box (SEEC and SESP).

Open from Active Workspace Client

You can now open a browser, log into Active Workspace, find Solid Edge data that is managed by
Teamcenter, and send the document directly to Solid Edge. You can select an Item, Item Revision,
or Solid Edge dataset. Just click Open in Solid Edge, and the associated design data opens in
Solid Edge.

The Teamcenter preference, AWC_SEEC_OpenSupportedTypes enables the Open in Solid Edge
command and specifies the object types that Active Workspace Client can open in Solid Edge. If
this preference is not specified, the Active Workspace Client does not display the Open in Solid
Edge command.

For more information, see the help topics Open a Solid Edge document from Active Workspace and
Teamcenter Preferences in the Solid Edge Embedded Client Guide for Users and Administrators.

Structure Editor - Teamcenter

Multifield key support

Structure Editor-Teamcenter supports the use of multifield keys to define what makes an Item
business object unique in Teamcenter.

Prior to Teamcenter 10, Item business object uniqueness was defined using a single property, Item
ID. Beginning with Teamcenter 10, Item business object uniqueness is extended to include additional
properties (such as Item ID and Type). When the Teamcenter functionality is deployed, Structure
Editor-Teamcenter is able to open an Item, Item Revision, or dataset where the Item’s object’s
uniqueness is defined by key properties. Additionally you can:

• Create new items whose uniqueness is defined by key properties.

• Use Save As to create a new object for an Item type whose uniqueness is defined by key
properties.

• Use Save As to overwrite data for an Item Type whose uniqueness is defined by key properties.

Add to Teamcenter Interactive

Add to Teamcenter – Interactive

While Add to Teamcenter continues to be the application for bulk import and a critical path in getting
existing Solid Edge data into Teamcenter, this tool provides you an interactive process for adding
Solid Edge 3D and draft data to Teamcenter.

With a focus on working with unmanaged data that is of a product or project in size, it is particularly
suited for supply chain collaboration and reintegration of formerly managed content into Teamcenter.
Data validation and error checking are combined into an interactive user interface to assist you
with managing your designs.

Add to Teamcenter Interactive is available to you when you install the Solid Edge Teamcenter Client
and it includes robust help information to assist you with using the application.
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Multifield key support

Add to Teamcenter-Interactive supports Teamcenter’s use of multifield keys to define what makes
an Item business object unique in Teamcenter.

Prior to Teamcenter 10, Item business object uniqueness was defined using a single property, Item
ID. Beginning with Teamcenter 10, Item business object uniqueness is extended to include additional
properties (such as Item ID and Type). When the Teamcenter functionality is deployed, Add to
Teamcenter-Interactive is able to open an Item, Item Revision, or dataset where the Item’s object’s
uniqueness is defined by key properties. Additionally you can:

• Create new items whose uniqueness is defined by key properties.

• Use Save As to create a new object for an Item type whose uniqueness is defined by key
properties.

• Use Save As to overwrite data for an Item Type whose uniqueness is defined by key properties.

Insight

Insight software compatibility

Solid Edge Operating System SQL Server SharePoint
Foundation SharePoint Server

2008 R2,
2012/2012 R2 2008 R2, 2012 Search Server

Express 2010 SP2 2010 SP2
ST8

2012/2012 R2 2012 or 2014 2013 SP1 2013 SP1
Windows Server 2008 and 2008 R2 life cycle ended prior to Solid Edge ST8 release. Testing with
Windows Server 2008 R2 only.

SQL Server 2008 and 2008 R2 life cycle ends with Solid Edge ST8 release. Testing with SQL
Server 2008 R2 only.

SharePoint 2013 SP2 includes a bug that affects SharePoint search. Recommend SP1 until SP2
+ hotfix is available.

SharePoint Foundation 2010 is not supported with Microsoft SQL Server 2014.

Microsoft Product Lifecycle (EoSM):

• 1/13/2015 Windows 2008 and 2008 R2

• 7/8/2015 SQL Server 2008 and 2008 R2

• 10/13/2015 SharePoint 2010

Insight Server supports User Account Control (UAC)

Insight Server setup and Insight Server applications are now supported with UAC enabled. User
Account Control Settings no longer need to be turned off for Insight server or client installation.
This includes the server installations:

• Windows Server 2008 R2

• Windows Server 2012
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• Windows Server 2012 R2

and the Insight Server applications:

• Insight Server for SharePoint Foundation 2010

• Insight Server for SharePoint Foundation 2013

Insight supports new shortcut commands

Insight supports new shortcut commands with SharePoint 2010 and SharePoint 2013:

• Open with Life Cycle Assistant

• Open with Revision Manager

Note

Not available for .pcf files.

• Open with View and Markup

• Where Used

• Insert Component

Note

Not available for .pcf files.

The shortcut command menu is delivered when you select Solid Edge Insight Document
Library Shortcut Menu as one of the Site Collection Administration Features that you enable
when you configure Insight.

Creating a network location to a SharePoint site or document library

The Network locations you define to a SharePoint site or document library should be created using
a UNC path (example: \\server\sites\insight).

Creating the network location using a URL (http://server/sites/insight) can result in missing or
disabled functionality with:

• Search

• Toolbar

• Shortcut commands

Note

This change has no impact to your entries in searchscope.txt.

See the Working with Insight chapter of the Solid Edge Insight Implementation guide for additional
information.
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Support for simplified assemblies

Simplified assemblies and the associated performance benefits of using a simplified representation
of an assembly when you are working with a large assembly are now integrated into the Insight
managed environment in Solid Edge. Insight is able to take advantage of simplified subassemblies,
reducing the depth of the product structure expansion and the number of files downloaded to cache
when Large Assembly is selected on the Open File dialog box or when Auto-Select detects a large
assembly and the Assembly Open As option is set to Use all simplified.

For more information on working with simplified assemblies in Insight, see the Simplifying assemblies
Help topic.

Increment file name

ST8 provides new Solid Edge options that combine with the file name to determine the revision
number.

You can find these following options in the Solid Edge Options dialog box →General tab:

• Revision delimiter

• Starting revision value

• Maximum length

• Excluded characters

The Increment Filename command uses these Solid Edge options, the Revision Number file
property, and the segment of the file name identified as the Revision. A non-null Revision Number
file property is given precedence over the value found in the file name. The Increment Filename
command increases the Revision Number file property by one unit and stores the new value in the
file then updates the file name to reflect the new file property value. The Manage→Revisions dialog
box and the Revise command in Revision Manager use the same approach.

To copy or revise an existing document, use the Increment name command to create a new file
name by incrementing the Revision portion of the file name by one unit. The command uses the
Solid Edge options to find the existing Revision value, then finds the portion of the file name that is
subject to change. If the Revision value is missing, the revision delimiter and the Revision Number
are added to the end of the existing file name.

To learn more, see Revising assemblies.

2D Loader Preferences added to Options dialog box

In View and Markup and Revision Manager, the Options dialog box→View tab now includes the 2D
Loader Preferences command, which displays a dialog box for defining the location of Cyrillic fonts
as well as many other parameters for CGM, DWG/DXF,DGN, DFT, HPGL and ME10 file formats.
Previously, the font had to be located in the same folder as the files to be viewed.

For more information, see the help topic, 2D Loader Preferences dialog box, in the View and Markup
and Revision Manager Help.
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Modify file open when viewing a .pcf

Use the Add to PCF command before you add a non-pcf document to an open .pcf file. Previously,
the Open command automatically added the file. This behavior assures that you only add documents
intentionally.

For more information, see the Add to PCF command in View and Markup and Revision Manager Help.

Support for 3D measure commands

Solid EdgeViewer supports 3D measure commands when you open a 3D file for viewing.

For more information, see Adding markup and measurements to documents in the View and Markup
Help.

Support for PMI commands in all viewers

All Solid Edge based viewers - View and Markup, Solid Edge SP Viewer and the Solid Edge Viewer,
support PMI commands now.

The PMI commmands include the following:

• Multiple Entity Mode

• Previous Entity
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• Single Entity Mode

• Next entity

• Filter Configuration Filters

• Reorient Text

• Undo All

• PMI preferences

You can control the display through the PMI pane in the edgebar display.

To learn more, see the Displaying Product and Manufacturing Information in the View and Markup
help.

Solid Edge SP

Object linking from within Solid Edge

Solid Edge SP now enables you to create and link objects from within Solid Edge, using the Linked
Objects dialog box, accessible from the Link Objects button in the Common Properties
dialog box (CPD).

The Linked Objects dialog box is also available from the Solid Edge SP Client and the Structure
Editor.
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Advanced workflows

To improve performance, we redesigned the workflow architecture. In addition, we added new
workflow actions for data export and release, to enable you to:

• Generate and export BOM reports

• Create neutral file formats

• Generate sign-off PDFs

For more information, see the Solid Edge SP Implementation Guide, available as a PDF at
C:\Program Files\Solid Edge ST8\Program\ResDLLs\0009\SEforSPImplementationGuide.pdf.
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New navigation feature in the Content Browser

To improve the overall usability of Solid Edge SP, we added a new navigation feature in the Content
Browser, Quick Find.

Enhanced Preview/Properties Card functionality

You now have access to entire part information from the Preview/Properties Card.

Support for lookup and calculated columns

Solid Edge SP now supports two more SharePoint columns: lookup and calculated columns.
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Enhanced distribution of design data

Solid Edge SP now makes it easier for you to share information with colleagues who do not have
Solid Edge SP. To facilitate data sharing, we:

• Added the Download Copy functionality so you can save Solid Edge SP files to your local
directory.

• Improved your options for .zip file creation by making it easy for you to select any file types and
save .zip files to your local directory.

• Added new workflow actions to allow for automated data export.
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Improved the Move command

The Move command is now much faster and can run in the background so you can continue to work.
In addition, the Move command now adheres to document library-specific status. For example, if
you move an object from the Sandbox site to the In-House site, the object status changes from
Sandbox to Working .

Support for SharePoint 2013

You can now run Solid Edge SP on SharePoint 2013, in addition to SharePoint 2010.

New interactive simulations

The simulations in the Solid Edge SP self-paced training allow you to experience running Solid
Edge SP, without the need to install anything. The Solid Edge SP self-paced training includes two
new simulations.

• In the conceptual simulation, Prepare data for import, we give you an overview of the data
preparation and import process.

• In the interactive simulation, Release an object, you learn how to release objects to prevent
unauthorized changes.

To access the self-paced training, from the main Solid Edge ST8 Help and Training home page, in the
Learn to use Sold Edge section, click Self-paced and classroom courses. Scroll down to the Design
data management courses category, and then select the course,Working with Solid Edge SP.

Translator and converter enhancements

STEP Export Options dialog box enhanced

Enhancements have been made to the STEP Export Options dialog box:

• The dialog box now supports AP242.

• The Solid Bodies, Export to option has been removed from the dialog box so you no longer
have to specify the class entity for STEP.
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Support of callouts in AutoCAD enhanced

Enhancements have been made to text placement, formatting, and scaling within callouts when
exporting to or importing from AutoCAD.
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IFC translation supported

You can now save Solid Edge assembly, part, and sheet metal files to Industry Foundation Classes
(IFC) IFC2X3 or IFC4 format. IFC is the preferred data exchange method when collaborating with
Building Information Modeling (BIM) based projects.

You can also open IFC files as Solid Edge assembly, part, and sheet metal files.
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SolidWorks virtual components supported

The SolidWorks data migration tool supports virtual components.

SolidWorks virtual components are parts or assembly bodies that are embedded within the
SolidWorks assembly. By default, SolidWorks virtual components are created when a part or
assembly is created within the context of an existing assembly. Common examples of virtual
components are SolidWorks assemblies that contain pipes or frames.

For more information, see SolidWorks data migration.

User interface changes

Access to social media from the Solid Edge startup screen

The Solid Edge startup screen gives you direct access to social media sites:

• YouTube

• Facebook

• Solid Edge Community blog
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A new Design Intent interface replaces the Live Rules interface

A new Design Intent panel displays the design intent (symmetry, tangency, coplanar, and other
similar relationships built into your model) that you can choose to preserve or ignore during a
synchronous move. For more information, see Using the Design Intent panel.
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Changes to the Application Display settings

For modeling environments, the Solid Edge Options dialog box →View tab →Application Display
section settings have changed:

• The list now contains Graphics card driven (Advanced), Graphic card driven, Software
driven (Advanced) and Software driven. The Graphics card driven (Direct 3D) and Backing
store options were removed.

• The Use display buffers option replaces use display lists.

To learn more, see Optimizing Solid Edge display performance.
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Improved face style mapping

Face styles in ST8 are more compatible with KeyShot materials. Previously, Solid Edge display did
not have all of the characteristics required for optimal KeyShot rendering. The Solid Edge style
converter also includes enhancements to improve the mapping between Solid Edge face styles
and KeyShot materials.

To update files to the ST8 styles, see Copy a style to a document.
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Look At Face supports PMI sections

You can use the Look At Face command and select a PMI section face. Previously you could not
locate a PMI section face.

For more information, see the Look At Face command.
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Solid Edge Mobile Viewer for Windows 8

The new Solid Edge Mobile Viewer is an application for viewing Solid Edge designs on mobile viewing
devices running the Windows 8 operating system.

The mobile viewer lets you rotate, zoom, fit, and pan views of your designs, manage backgrounds,
and selectively hide and show components of the designs. You can save and email screen shots of
the views you create.

A special Solid Edge Viewer file type represents your designs for the mobile viewer. The files are
lightweight, containing only view information. You create them in Solid Edge with either the Save As
command or the Save for Tablet command. Solid Edge Viewer file names have .sev extensions.

For more information, see the help topics, Solid Edge Mobile Viewer for Windows.
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Template list changes

The New dialog box now displays folder structure.
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Solid Edge Spotlight

The Solid Edge Spotlight displays in-view, interactive navigation that connects you with resources
related to Solid Edge.

The information provided can include:

• Notification of upcoming seminars, webinars, and training opportunities.

• Resources for becoming more proficient with Solid Edge.

• Case studies.

Additional information is available in Solid Edge Spotlight.

User assistance tools

Contextual help

• You can press F1 whenever you need help during a design session.

• You can press Shift+F1 to initiate context help . When this tool is displayed, you can click a
command on the ribbon to display help.
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Where is user help?

You can find the product version, user help, tutorials, Programming with Solid Edge, other documents,
and a technical support link in their new home on the Learn Solid Edge docking window .

If you do not see the Learn Solid Edge tab along the perimeter of the application window, you can

find it by clicking the Help Index button , which is located at top-right on the ribbon. For more
information, see: User assistance features in Solid Edge.

To learn how to search the entire help and training collection to find what you need, see the help
topic, Resources for learning Solid Edge.
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Operating system requirements and information
Solid Edge ST8 has been certified to run on the following:

• Windows 8 or 8.1 Enterprise or Professional (64-bit only)

Note

Windows 8 (Home) and Windows 8 RT are not supported

• Windows 7 Enterprise, Ultimate or Professional (64-bit only) with Service Pack 1

• Internet Explorer 10 or 11 (IE 8.0 meets minimum requirements)

Note

Internet Explorer is not required to be the default browser.

Solid Edge stops certifying new releases against an operating system shortly after
Microsoft drops mainstream support for it. Solid Edge does not install on Windows XP or
Windows Vista. Be sure to consult the readme file for the latest information available.
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Hardware system requirements
Insight Connect hardware and software requirements follow the recommendations for Solid Edge. Be
sure to consult the Solid Edge Readme.htm for additional information.

Recommended system configuration

• 64-bit (x64) processor

• Windows 7 operating systems

• At least 8 GB RAM

• True Color (32-bit) or 16 million colors (24-bit)

• Screen Resolution: 1280 x 1024 (or higher, following the manufacturer's recommendations)

Minimum system configuration

• 64-bit (x64) processor

• Any of the supported operating systems

• At least 2GB RAM

• 65K colors

• Screen Resolution: 1280 x 1024 (or higher, following the manufacturer's recommendations)
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Display System Requirements and Information
Solid Edge will run on graphics drivers that support Windows 7 or Windows 8. Contact your graphics
driver manufacturer to determine whether their graphics adapter/driver support these operating
systems.

For optimal performance, it is recommended to use a professional graphics card
that is designed for CAD applications. For information about cards used in testing
Solid Edge and results, refer to the Certification page of the Support web site:
http://support.industrysoftware.automation.siemens.com/gtac.shtml.

At least a 256MB graphic card is recommended when working with large assemblies or complex parts.

Note that running with extremely high screen resolution and color depth increases the memory
requirements on the system and may result in apparent performance degradation. If experienced,
reconfigure the display system to the recommended resolution and color depth for improved
performance.

When running Solid Edge, if you experience an abnormally high abort rate, parts
disappearing, or other graphic anomalies you may not be using the appropriate
graphics driver. For more details, refer to the Certification page of the Support web site:
http://support.industrysoftware.automation.siemens.com/gtac.shtml.

Also setting Display Fonts to Large Fonts or Extra Large Fonts (larger than 96 DPI) may cause
some Solid Edge user interface items to not display as intended. Recommendation to resolve these
would be to use Normal Fonts (96 DPI).

Solid Edge is optimized for a wide-screen ribbon layout. This ribbon layout is optimal for horizontal
screen resolutions set to 1920 or above. Solid Edge automatically detects your resolution and sets
the ribbon layout to wide-screen starting at horizontal resolutions 1600 and above. Some groups
collapse on the right side of the ribbon with resolutions between 1600 and 1920.

To take advantage of High-Quality rendering mode you must use a card that supports Open GL
version 3.0.

Solid Edge ST8 Release Notes 1-73

Solid Edge ST8 Release Notes

http://support.industrysoftware.automation.siemens.com/gtac.shtml
http://support.industrysoftware.automation.siemens.com/gtac.shtml


Lesson 1: Solid Edge ST8 Release Notes

System Resource Requirements and Information
Earlier versions of Solid Edge were enhanced to access the extended address space that is available
on Windows. All running processes, including the Operating System process, share 4 GB of
addressable memory available, regardless of the amount of physical RAM. Normally, the operating
system reserves 2 GB of space and leaves 2 GB for applications. Running 32-bit operating systems
with the /3GB switch added, reserves only 1 GB for the operating system, and leaves 3 GB for
applications. This allows you to work with larger datasets without running out of addressable space.

On Windows 7 with administrator privileges, you can run the following command from the command
line to enable /3GB switch:

BCDEDIT /Set IncreaseUserVa 3072

This command tells you what options are part of the OSLOADER family:

bcdedit /? types osloader

To reset the value, use:

bcdedit /deletevalue IncreaseUserVa

The 64-bit Solid Edge supports up to 128 GB of physical RAM and 16 terabytes of virtual memory,
enabling applications to work with larger data sets. The 64-bit version of Solid Edge requires 64-bit
Windows operating systems loaded on Intel EM64T or AMD64 processors.

Page file size should be the maximum size possible. In general, the page file size should be at least
twice the amount of memory in the machine, plus the size of files you will use.

Processor Support

Component software delivered with Solid Edge, such as Parasolid and D-Cubed, started phasing out
processors not supporting Intel's SSE2 (Streaming SIMD Extensions 2) instruction set. In 2009, these
components will only support processors with SSE2.

SSE2 is one of the Intel SIMD (Single Instruction, Multiple Data) processor supplementary instruction
sets first introduced by Intel with the initial version of the Pentium 4 in 2001. AMD added support for
SSE2 with the introduction of their Opteron and Athlon 64 ranges of AMD64 64-bit CPUs in 2003.

Here is a list of common processors that do not support the SSE2 instruction set:

• AMD CPUs prior to Athlon 64

• Intel CPUs prior to Pentium 4

Solid Edge only supports processors that include the SSE2 instruction set. The Solid Edge installation
checks for the presence of such a processor. If this processor does not exist, installation stops and
displays a message explaining this dependency.
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Temporary File Space
Solid Edge uses temporary file space to save files and to store memory mapped display files. Using
temporary file space when saving files helps significantly reduce the size of the resulting file on
the destination file system.

You should ensure that you have twice as much free temporary file space as the size of the largest
file being saved. The file size includes the size of the assembly, the size of the subassemblies that
are being used, and the size of the part files.

Running Solid Edge creates temporary memory mapped files that are used to support the display
system. When you open assembly and part files, memory mapped files are created in the temp
directory on the hard drive only while the files are displayed. The memory mapped files are deleted
after exiting the Solid Edge file. If the system runs short on temporary space on the primary drive, you
can set an environment variable called JRENDER_TEMP and define another folder on a drive with
sufficient space and then Solid Edge creates the memory mapped files in the new location.

Running Solid Edge creates a file named DCCACHE.tmp in the system temp folder. This file is a
cache of the file icons displayed on the dialogs for browsing, opening, and saving files.

If Solid Edge files are not properly associated with the product, try deleting this file and restarting
the product.

It is good practice to periodically delete files in temporary folders so your system is not using
unnecessary disk space.
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